ABSTRACT
OLAP Cubes are extremely useful in storing and pre-summarizing large data volumes for quick queries. SAS® OLAP Cubes can be created in Proc OLAP steps or via SAS OLAP Cube Studio while cube measures can be defined within these. Find out how these same measures are defined and managed as well as some of the advantages and disadvantages we have come across.

DEFINITIONS
OLAP – OnLine Analytical Processing
MDX – Multi-Dimension Expressions
Metadata – Data about the data, such as label, format, etc.
Sets – A defined group of members, typically a subset of the data that is utilized frequently for querying or measuring by.

DEFINING CUBE MEASURES IN PROC OLAP
Within Proc OLAP, the MEASURE statement is used to define the measurement name, statistics, source column, and associated metadata.

```sas
measure Sales_Sum
  stat=sum
  aggr_column="SumOfSales"
  analysis="Sales"
  desc='Sum of Sales'
  units='Dollars'
  format=dollar10.2
;
```

Required Elements Include Measure, Stat, and Column or Aggr_Column.
1. Measure Names can be 32 characters in length and spaces, mixed letters and special characters can be utilized just surround with single quotes and add an n, for example 'Product@RatioB'n.
2. Stat options are minimal.
3. Column or Aggr_Column provide the variable name that is the source for the statistic.

DEFINING CUBE MEASURES IN SAS® OLAP CUBE STUDIO
OLAP Cube Studio offers users an interface to create the same measure that is available to define within the PROC OLAP Code.
As the user completes the OLAP Cube Studio Cube Designer, the Select Measures screen is offered.
After selecting the measures, the user then is able to modify the metadata.
From OLAP Cube Studio Help, the following are definitions of these Metadata Attributes.

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure Name</td>
<td>Displays the names of all the measures defined for the cube. The measure name is a valid SAS name (up to 32 characters) that you can modify.</td>
</tr>
<tr>
<td>Input Column</td>
<td>Displays the names of the columns in the input data source that contain the values that will be used to calculate the statistic shown in the corresponding Statistic column. This field is read-only.</td>
</tr>
<tr>
<td>Statistic</td>
<td>Displays the names of the statistics that you selected on the Select Measures window of the Cube Designer wizard. For a list of available statistics, see Statistics Available for Measures. This field is read-only.</td>
</tr>
<tr>
<td>Caption</td>
<td>Displays a caption for each measure. You can enter up to 256 characters. Third-party applications that report on cube data can be designed to display this measure caption.</td>
</tr>
<tr>
<td>Format</td>
<td>Displays a format for each measure. The default format depends on whether or not the cube is loaded from a fully summarized data source. For cubes that are not loaded from a fully summarized data source, the statistics SUM, MIN, MAX, RANGE, AVG, STD, STDERR, LCLM, and UCLM use the format assigned to the input column.</td>
</tr>
<tr>
<td>Format Used</td>
<td>For cubes that are loaded from a fully summarized data source, the default format is BEST12. To change the default, click in the Format field to enable a drop-down list of SAS formats, then select the format that you want to assign to the measure. After you have selected a format, you can choose to change the default width and decimal places by clicking in the field. For example, you might select DOLLAR and then type 8.2 to specify the width (8) and the number of spaces to the right of the decimal point (2). Your selected SAS format will be used to display the value of the corresponding measure.</td>
</tr>
<tr>
<td>Units</td>
<td>Displays a unit description for each measure. You can enter up to 256 characters that are used to display a description of the measure's units (for example, Pounds Sterling).</td>
</tr>
<tr>
<td>Description</td>
<td>Displays a description for each measure. You can enter any number of characters to create an optional description that is associated with the measure. The default description is the measure name. Third-party applications that report on cube data can be designed to display this measure description.</td>
</tr>
</tbody>
</table>
DEFINING MEASURES IN SAS OLAP CUBE STUDIO – CALCULATED MEMBERS

Within the Calculated Members option of SAS OLAP Cube Studio (SP4), users can create custom measures for use by cube users. This same plug in is available from DI Studio.

Simple Calculations, Time Analysis Calculations and Custom Calculations are available options. Within this user interface, advanced measures such as ratios, time period comparisons and those requiring MDX functions can be defined for use during OLAP viewing through SAS Enterprise Guide or SAS Web OLAP Viewer. Changes in this area of OLAP Cube Studio will not necessitate regeneration of the OLAP code, the new measures are immediately available within the client tools.

Note: To utilize the calculation type ‘Time analysis calculation’, a valid Time Dimension is required. This is defined during cube creation. Included is a screenshot of this option from OLAP Cube Studio.
After ‘Time analysis calculation’ is selected, available time calculations are shown on the following Calculate Member Interface:

**Opening Balance** – Provides the measure total for the first time period selected in a set.

**Closing Balance** – Provides the measure total for the last time period selected in a set.

**Rolling Total** – Sums the measure over each time period.

**Average Over Time** – Averages the measure over each time period.

**Compare Parallel Periods** – Gives the difference of the measure over the same time period in the previous.

**Compare Consecutive Periods** – Gives the difference between the current time period and the previous time period.
DEFINING MEASURES IN MDX
During PROC SQL queries on OLAP cubes, custom measures can be defined and utilized immediately.

Included is a sample query below.
/*Start the SQL statement, connect to the OLAP system*/
proc sql;
connect to olap (host="sasservername" port=8561 user="sasuser" pass="saspassword");
/*Create a table*/
CREATE TABLE work.sample as select * from connection to olap (WITH
/*Create a custom measure & also the location to define sets*/
MEMBER Measures.Ratio AS
CoalesceEmpty(
[Measures].[Cancels]
/
([Date].[Date].CurrentMember, &GroupVar, [Measures].[TotalCount]),0)
SELECT
/*All measures are selected*/
     { [Measures].AllMembers } ON COLUMNS ,
/*Establish Row Selected*/
     { CrossJoin ( {[Date].[All Date].[&year].[&mo] },
        &GroupVar )
     } ON ROWS
/*Define Cube to Select From*/
FROM [cube] );
DEFINING MEASURES VIA SAS ENTERPRISE GUIDE

Analytic users can open OLAP cubes in SAS Enterprise Guide and derive additional measures. Included are the screenshots to connect to open a cube and create a new measure.

1. File -> Open -> OLAP Cube:

![Screenshot 1: File -> Open -> OLAP Cube]

2. Select the OLAP Cube to view:

![Screenshot 2: Select OLAP Cube]

3. Add the Measure:

![Screenshot 3: Add Measure]

4. Name the Measure:

![Screenshot 4: Name the Measure]
5. **Select the Type of Analysis:**

   - **Simple calculations**
   - **Time Series analysis**
   - **Trends and Forecasting analysis**
   - **Cost analysis**
   - **Relative Contribution analysis**
   - **Custom calculation**

6. **Specify type of measure:**

   - Member contribution relative to a total value
   - Member contribution relative to its parent
   - Show result as percentage

7. **Select the measure this relates to:**

8. **Select the dimension (and hierarchy that this measure is based on):**
9. Specify other parameters:

Create New Calculated Member

Step 6: Specify Other Parameters

Specify the parent, dimension, level, format, and solve order for the new calculated member.

- Parent dimension: MEASURES
- Insert at level: Measures
- Use format: Percent %
- Solve order: 0

10. Mark whether this is available again:

Create New Calculated Member

Step 7: Select the Scope

Specify how long you would like to keep the new calculated member.

- Type of scope:
  - Temporary
  - Available during this session only
  - Global, always available

- Add to current query

11. Results:

<table>
<thead>
<tr>
<th>Region</th>
<th>Measures</th>
<th>Level</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>1.3%</td>
</tr>
<tr>
<td>Pacific</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>6.7%</td>
</tr>
<tr>
<td>Africa</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>6.9%</td>
</tr>
<tr>
<td>Eastern Europe</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>7.0%</td>
</tr>
<tr>
<td>South America</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>7.1%</td>
</tr>
<tr>
<td>Central America/Caribbean</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>10.8%</td>
</tr>
<tr>
<td>Canada</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>12.5%</td>
</tr>
<tr>
<td>Interamerica</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>14.4%</td>
</tr>
<tr>
<td>United States</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>16.2%</td>
</tr>
<tr>
<td>Middle East</td>
<td>Sales</td>
<td>Contribution Margin</td>
<td>16.6%</td>
</tr>
</tbody>
</table>

Sales Contribution Margin

![Graph showing sales contribution margin for various regions]
UTILIZING SETS
Sets are used to define a subgroup of the cube data. These can be defined within the MDX query or via SAS Information Map Studio.

The first set sample is defining a date range subquery from April to July 2006.
Set [daterange] as { [DateValue].[All DateValue].[2006].[04] : [DateValue].[All DateValue].[2006].[07] }

To utilize this set, you would then declare a member such as:
Member [DateValue].[Filter] as 'sum([daterange])'

The second sample is defining a specific state to query on:
Set [NCOnly] AS { [States].[All States].[North Carolina] }

Again to utilize this set, you would then declare a member such as:
Member [States].[sub] as 'Aggregate([NCOnly])'

To include multiple states within a set, a comma needs to be used between the members:
Set [EasternSeaboard] AS { [States].[All States].[Maine], [States].[All States].[New York], [States].[All States].[Pennsylvania], [States].[All States].[Maryland], [States].[All States].[New Jersey], [States].[All States].[North Carolina], <etc> }

Utilize this set by declaring a member such as:
Member [States].[sub] as 'Aggregate([EasternSeaboard])'

Defining Sets in Information Map Studio is as simple as defining a Filter.
After inserting the Cube into a new map and selecting data items, click the Filter Icon to display the Screen below. Select the corresponding Hierarchy Values that would be part of the filter.

When you then move to Test (found under the Tools tab), you can select the filter and click the View Query button to see the Sets dynamically created by SAS Information Map Studio.
Sets Created

Filter Included

View Query

Sets Created
RECOMMENDATIONS

1. Both MDX, Calculated Members and Proc OLAP Measure statements are extremely efficient and perform essentially the same.

2. Proc OLAP Measure statements and the Cube Measure GUI both require a complete refresh of the OLAP cube. Whereas Calculated Members in 9.1.3SP4 and MDX code can be utilized immediately against the OLAP Cube.

3. The flexibility of Calculated Members and MDX is apparent, offering a wider range of calculation options.

4. One common issue with using complex members/calculations is that they frequently require settings on the OLAP server to be reconfigured in order to prevent users from hitting memory or processing constraints. Configuration changes and optimizations include:
   a. Increasing the MEMSIZE setting in the OLAP Server Configuration File
      i. This configuration file is located at \Lev1\SASMain\OLAPServer\sasv9_OLAPServer.cfg
      ii. The default MEMSIZE is 512M.
   b. Increasing the maximum number of tuples per query in the OLAP server:
      i. http://support.sas.com/kb/19/363.html
   c. Creating an ARM log and running it through the Advanced Aggregation Tuning plugin within OLAP Cube Studio or DI Studio.

5. Adding Measures and Defining SETS in an Information Map slows performance significantly and is not recommended by our consultants.

ADDITIONAL READING

OLAP Server Administration Guide
CONTACT INFORMATION

Your comments and questions are valued and encouraged. Contact the author at:
Angela Hall
Zencos Consulting LLC
100 Regency Forest Dr, Suite 130
Cary, NC 27518
Work Phone: 919-459-4600
Angela.Hall@Zencos.com
http://www.zencos.com

SAS and all other SAS Institute Inc. product or service names are registered trademarks or trademarks of SAS Institute Inc. in the USA and other countries. © indicates USA registration.
Other brand and product names are trademarks of their respective companies.